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1 Introduction 

The TMD2636 evaluation kit comes with everything needed to evaluate the TMD2636. The device 

features advanced proximity measurement in a tiny and extremely thin optical land grid array module. 

1.1 Kit Content 

Figure 1:  

Evaluation Kit Contents 

 

 

No. Item Description 

1 TMD2636 Daughter Card PCB with TMD2636 sensor installed 

2 EVM Controller Board Used to communicate USB to I2C  

3 USB Cable (A to Micro-B) Connects EVM controller to PC 

4 Flash Drive Include application installer and documents 

 

1.2 Ordering Information 

 

Ordering Code Description 

TMD2636 EVM Miniature Proximity Sensor Module 
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2 Getting Started 

The software should be installed prior to connecting any hardware to the computer. Follow the 

instructions found in the Quick Start Guide (QSG). This loads the required driver for the USB interface 

and the device’s graphical user interface (GUI). 

The balance of this document identifies and describes the controls available on the GUI. In 

combination with the TMD2636 datasheet, the QSG and application notes available on the ams 

website, www.ams.com, there should be enough information to allow evaluation of the TMD2636 

device. 
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3 Hardware Description 

The hardware consists of the EVM Controller, the TMD2636 EVM daughter card, and a USB interface 

cable. The EVM controller board provides power and I2C communication to the daughter card through 

a seven-pin connector. When the EVM controller is connected to the PC through USB, a green LED 

lights on to indicate the system is getting power. 

For schematics, layout and BOM information please see the documents included with the install 

located in the TMD2636 EVM folder (All Programs -> ams -> TMD2636 EVM -> Documents). 

Figure 2:  

Evaluation Kit Hardware 
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4 Software Description 

The main window (Figure 3) contains the system menus, system level controls, device information and 

logging status. The main window contains only one tab “Prox” to configure the parameters to run 

proximity. The prox data and its average data is also plotted in this tab. The application polls the prox 

raw data continuously.  

Figure 3:  

GUI Main Window 

 

4.1 Connect Software to Hardware 

On startup, the software automatically connects to the hardware. On successful initialization, the 

software displays a main window, containing controls pertinent to the connected device. If the software 

detects an error, an error window appears. If “Device not found or is unsupported” appears, verify the 

correct daughterboard is properly connected to the EVM controller board. If “Cannot connect to EVM 

board” appears, verify the USB cable is connected. When the EVM controller board is connected to 

the USB, a green LED lights on power up to indicate the USB cable is connected and providing power 

to the system. The LED will remain lit until the any software application opens the controller. The light 

will then be switched off so that it will not interfere with any light measurements. 

If the EVM board disconnects from the USB bus while the program is running, it displays an error 

message and then terminates. Reconnect the EVM board and restart the program. 
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4.2 System Menus 

At the top of the window there are pull-down menus labeled “File”, “Log”, and “Help”. The File menu 

provides basic application-level control. The Log menu controls the logging function, and the Help 

menu provides version and copyright information for the application. 

4.2.1 File Menu 

The File menu contains the following functions: 

Figure 4:  

File Menu 

 

 

The Reread Registers function forces the program to re-read all of the control registers from the 

device and display them on the screen. This does not read the output data, because the program 

reads those registers continually while it is running. 

Click on the Exit command to close the main window and terminate the application. Any unsaved log 

data is cleared from memory. The application can also be close by clicking the red “X” in the upper 

right hand corner. 

4.2.2 Log Menu 

The Log menu controls the logging function and saves the log data to a file. Log data accumulates in 

memory until discarded or written to a data file. 

Figure 5:  

Log Menu 

 

 

Click Start Logging to start the logging function. Each time the program polls the output information 

from the device, it creates a new log entry showing the raw data values, the values of various control 
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registers, and the values entered by the user into the text fields near the bottom right corner of the 

window. 

Click Stop Logging to stop the logging function. Once logging stops, the user may store the data in a 

file, or continue collecting additional data by clicking Start Logging again. 

The Log a Single Entry command causes logging to start, collect one single entry, and immediately 

stop again. This function is not available when logging is already running. 

Click Clear Log to discard any previously collected data. If there is data in memory, which has not 

been saved to disk, this function displays a prompt asking to verify it is OK to discard the data. If the 

log is active when this function executes, the log continues running after the existing data is discarded. 

Click Save Log to save the collected log data to a csv file. This stops the logging function, if it is 

active, and displays a file dialog box to specify where to store the logged data. The Log Status and 

Control Information section below describes the default file name, but you may change the file name if 

desired. 

4.2.3 Help Menu 

The Help menu contains a single function: About. 

Figure 6:  

Help Menu 

 

 

The About function displays a dialog box (Figure 7) showing the version and copyright information for 

the application and library. Click the OK button to close this window and continue. 
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Figure 7:  

About Window 

 

 

4.3 System Level Controls 

Immediately below the top menu bar there are checkboxes used to control the system level functions 

of the TMD2636 device.  

The Power On checkbox controls the PON function of the TMD2636. When this box is checked, the 

power is on and the device is running measurements according the settings in the Prox tab. When this 

box is unchecked, the power is off and the device does not operate. 

The Prox Enable checkbox enable the proximity measurement when checked and disable proximity 

measurement when unchecked. 

4.4 Auto Polling 

The application automatically polls the TMD2636 raw data of the Prox. The Poll Interval at the right 

upper corner of the form displays the actually time between reads of the device. 

4.5 Device ID Information 

The lower left corner of the window displays the ID number of the EVM Controller board, identifies the 

device being used. 
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4.6 Log Status and Control Information 

The lower right corner of the window contains status information and controls for the logging function: 

Figure 8:  

Logging Status 

 

 

This section contains text boxes that are stored in the log file data and used to build the file name for 

the log file. If the data in these fields are changed, the new values are stored with any new data 

logged. The default file name is based on these values at the time the log file is written. If nothing is 

entered in these boxes they default to a period (“.”). 

Sample default file name: 

TMD2636_1-2-3_Log_HH_MM_SS.csv 

  From Application 

  From User Input 

The Count value displayed is a count of the number of samples currently in the log buffer. 

The Elapsed Time value indicates the elapsed time since data logging started. 

The numeric box in the bottom right-hand corner sets a limit to the size of the collected dataset. You 

may select a value from the pull-down list, or enter a value manually. When the number of entries in 

the log reaches this value, the program will automatically stop logging and display a file dialog box to 

specify where to store the logged data. You may change the file name if desired. The maximum value 

that may be entered in this field is 32000. 
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4.7 “Prox” Tab 

The main portion of the screen contains a tab labeled Prox. The controls in this tab are divided into 3 

sections, each performing a separate function. 

Figure 9:  

Prox Tab 

 

4.7.1 Prox Controls 

The PPULSE controls the number of pulses used for each prox cycle. The number of pulses is one 

more than the PULSE value and is displayed immediately to the right of the box. 

The PPULSE_LEN control sets the width of all pulses within the proximity cycle. Longer pulses result 

in increased proximity range and typically result in less electrical noise generated in the analog front 

end. 

The PGAIN control is pulldown menus that lets you control the gain stages of the proximity IR sensor. 

The PGAIN values are 1x, 2x, 4x and 8x. 

PLDRIVE control sets the drive strength of the IR VCSEL current. The values are 5,6,7,8 relating the 

drive current of 7 mA, 8 mA, 9 mA, 10 mA. 

The PWEN checkbox controls the proximity Wait feature. When this box is checked, the values for 

PWTIME and PWLONG determine the time between proximity cycles. When this box is unchecked, 

there is no wait period between proximity cycles and the values of PWTIME and PWLONG are 

ignored. 
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The PWTIME control sets the time to wait between prox cycles. PWTIME can be adjusted in 2.778 ms 

steps. 

The PWLONG checkbox controls the PWTIME factor. When this box is checked, the wait time 

between proximity cycles increases by a factor of 12x. 

The PDSELECT selects the photodiode to use for proximity detection. The values are “No 

photodiode”, “Far photodiode”, “Near Photodiode”, and “Both photodiode”. 

The POFFSET controls shift PDATA to remove crosstalk from the proximity data. The values range 

from -255 to 255. This value can be set manually, or it can be set by the Proximity offset calibration. 

The Auto Offset Adjust checkbox enables the function that automatically decrements the POFFSET 

value any time the PDATA value is 0. When this function is active, manual changes to the POFFSET 

control are disabled, and the program will read and update the POFFSET value each time it reads the 

PDATA value. 

The Calibration Group box. 

● The Cal button triggers the sensor’s proximity offset calibration sequence. This function 

automatically selects a POFFSET to remove crosstalk from PDATA. 

● The Average checkbox enables proximity hardware averaging as selected with PROX_AVG 

during calibration when checked. 

● The PRATE checkbox enables PRATE during calibration. It is useful when averaging is 

enabled. 

The APC function can be turned off with the Disable checkbox. This feature is used for hardware 

configurations with high crosstalk. When Auto Pulse Control is disabled, the range of the PDATA value 

is 0-1023. When the Disable checkbox is unchecked, the range of the PDATA value is 0-65535.  

The PROX_AVG control defines the number of ADC samples collected and hardware averaged during 

a proximity cycle. 

PRATE controls sets the duration of a single proximity sample. The time is equal to (PRATE + 1) * 

88 μs. The time, in microseconds, is displayed immediately under this control. 

4.7.2 Prox Output Data 

The top right corner of the Prox tab displays the output data. This data is continuously read. The 

polling interval is shown above the tab. 

● PDATA displays the Proximity ADC channel data counts. 

● ProxAvg displays the proximity data after software average of the last 32 PDATA.  

● StDev displays the calculated standard deviation of the last 32 PDATA samples displayed on 

the screen 
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4.7.3 Prox Data Plot 

The remaining portion of the Prox tab is used to display a running plot of the collected PDATA and 

ProxAvg values. The last 350 values are collected and plotted on the graph. As additional values are 

added, the old values will be deleted from the left side of the graph. To start the plotting function, 

check the Enable Plot checkbox. 

Figure 10:  

Prox Data Plot 
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5 Resources 

For additional information regarding the TMD2636, please refer to the datasheet. For information 

regarding the installation of the TMD2636 EVM host application software please refer to the TMD2636 

EVM Quick Start Guide. 

Designer’s Notebooks dealing with various aspects of optical measurement and optical measurement 

applications are available. All content is available on the ams website www.ams.com. 

 

 
For further information, please refer to the following documents: 

 

● TMD2636 Datasheet 

● TMD2636 EVM Quick Start Guide (QSG) 

● TMD2636 EVM User’s Guide (this document) 

● TMD2636 EVM Schematic Layout 
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6 Revision Information 

 

Changes from previous version to current revision v1-00 Page 

Initial Release  

  

  

  

  

  

  

 
● Page and figure numbers for the previous version may differ from page and figure numbers in the current revision. 

● Correction of typographical errors is not explicitly mentioned. 
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7 Legal Information 

Copyrights & Disclaimer 

Copyright ams AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved. 
The material herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the 
copyright owner. 

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and 
evaluation purposes only and are not considered to be finished end-products intended and fit for general consumer use, 
commercial applications and applications with special requirements such as but not limited to medical equipment or automotive 
applications. Demo Kits, Evaluation Kits and Reference Designs have not been tested for compliance with electromagnetic 
compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation Kits and Reference Designs 
shall be used by qualified personnel only. 

ams AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time 
and without notice. 

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a 
particular purpose are disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or 
consequential damages arising from the inadequacy of the provided Demo Kits, Evaluation Kits and Reference Designs or 
incurred losses of any kind (e.g. loss of use, data or profits or business interruption however caused) as a consequence of their 
use are excluded. 

ams AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property 
damage, loss of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any 
kind, in connection with or arising out of the furnishing, performance or use of the technical data herein. No obligation or liability 
to recipient or any third party shall arise or flow out of ams AG rendering of technical or other services. 

 

RoHS Compliant & ams Green Statement 

RoHS Compliant: The term RoHS compliant means that ams AG products fully comply with current RoHS directives. Our 
semiconductor products do not contain any chemicals for all 6 substance categories plus additional 4 substance categories (per 
amendment EU 2015/863), including the requirement that lead not exceed 0.1% by weight in homogeneous materials. Where 
designed to be soldered at high temperatures, RoHS compliant products are suitable for use in specified lead-free processes.  

ams Green (RoHS compliant and no Sb/Br/Cl): ams Green defines that in addition to RoHS compliance, our products are free 
of Bromine (Br) and Antimony (Sb) based flame retardants (Br or Sb do not exceed 0.1% by weight in homogeneous material) 
and do not contain Chlorine (Cl not exceed 0.1% by weight in homogeneous material). 

Important Information: The information provided in this statement represents ams AG knowledge and belief as of the date that 
it is provided. ams AG bases its knowledge and belief on information provided by third parties, and makes no representation or 
warranty as to the accuracy of such information. Efforts are underway to better integrate information from third parties. ams AG 
has taken and continues to take reasonable steps to provide representative and accurate information but may not have 
conducted destructive testing or chemical analysis on incoming materials and chemicals. ams AG and ams AG suppliers 
consider certain information to be proprietary, and thus CAS numbers and other limited information may not be available for 
release. 

 

Headquarters 

ams AG 

Tobelbader Strasse 30 

8141 Premstaetten 

Austria, Europe 

Tel: +43 (0) 3136 500 0 

Please visit our website at www.ams.com 

Buy our products or get free samples online at www.ams.com/Products 

Technical Support is available at www.ams.com/Technical-Support 

Provide feedback about this document at www.ams.com/Document-Feedback 

For sales offices, distributors and representatives go to www.ams.com/Contact 

For further information and requests, e-mail us at ams_sales@ams.com 
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